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Spreadsheets

What is a spreadsheet?
A spreadsheet is a working area on to which numbers and text are entered in rows
and columns. The area where each row and column meet is called a cell. Each
cell contains numbers or text.

Almost any type of calculation that can be set up in rows and columns can be
done with a spreadsheet. A spreadsheet is made up of many individual cells.
Microsoft Excel has 256 columns and 65 536 rows, making a total of 16 777 216
cells.

An Excel file is called a workbook. Each workbook is made up of a number of
worksheets. A worksheet is the area in which numbers and text are entered.
Figure 9.1 shows a typical worksheet that contains seven rows and six columns. It
contains information about sales over a twelve month period.

Rows are numbered from 1 to 65 536 and columns are identified by letters
from A to Z then AA, AB–AZ, BA, BB–BZ and so on. The last column finishes at
IV.

Each cell can contain a:

• number—for example, 45, 99.43, -887
• piece of text—for example, Gillian Jones
• formula—for example, =A1*2, which multiplies the value in cell A1 by 2
• function—for example, =SUM(A1:A12).

Why use a spreadsheet?
A spreadsheet is a very good way to solve problems that involve calculations. It is
also useful for displaying data that is arranged in a table. Some examples of
typical uses for a spreadsheet are:

• finding out how much interest can be earned over a period of time with a
particular investment

• preparing a budget
• working out how much money must be repaid when taking out a loan
• keeping track of the value of a portfolio of shares.

How is a spreadsheet organised?
The location of a cell is referred to by the letter representing the column and
then the number of the row. For example, cell B5 refers to the cell in column B,
row 5.
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The term ‘active cell’ refers to the cell that is being worked on at that instant.
The contents of the active cell appear in the formula bar. The names along the
top of the window are the various menus that contain commands to be used with
the spreadsheet.

Your turn
1 Write down what is contained in the following cells of Figure 9.1: A5, E6, F3.
2 Looking at Figure 9.1, write down the cell references for: Revenue, $10,285, Gina’s Profit

Report 2006.

Moving around a spreadsheet
The screen can display only a part of the worksheet at any one time. This display
is called a window. Any part of the worksheet may be displayed in a window by
moving the cursor. The cursor may be moved by using:

• the arrow keys
• the mouse
• the TAB key
• the Go To command on the Edit menu.

You can also move around the worksheet using:

• the scroll bars
• the PGUP and PGDN keys.

However, the cursor does not move using these methods unless you click in a
cell, making it the active cell.

Getting help
The Office Assistant can be used to get help. Click on the
Office Assistant button on the toolbar. This brings up the
animated icon representing the Office Assistant and a
dialogue box, which is used to access the Help database.

Figure 9.1
A sample
spreadsheet

Figure 9.2
Help button and
Office Assistant icon
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Your turn
1 Use the Office Assistant to find all the ways you can move around a worksheet.
2 Open a new worksheet and use each of these ways to move the cursor around the screen.

Move to the last row, then the last column. What is the cell reference of the cell in the
last row and last column?

3 Move the cursor to the cell G110 and write down what you did to get 
there.

Entering text
Text is entered in a cell by making that cell active then using the keyboard to
enter the text. Once the text is correct, press the ENTER key to accept it.

Text is used to provide meaning to the worksheet with headings and labels for
cells, rows and columns. Labels help explain what the numbers in a cell represent.

Example—Going to the movies
This example uses a worksheet to work out the cost of going to the movies.
The costs might include transport to the theatre, the cost of the ticket and 
food and drink at interval or after the show.

First, set up the headings:
• create a heading in the first row of the second column, cell B1
• in the first column, starting at A3, enter labels for each row: transport, ticket, food, drink
• in A8, enter the label TOTAL.

The worksheet is shown in Figure 9.3.

The width of a column may need to be changed to ensure that all the text can
be displayed. To change the width of a column, move the cursor to the line
between the columns until it changes to a double-headed arrow then double click
the left button. This adjusts the column width to fit all the text.

Figure 9.3
Going to 
the movies 
spreadsheet



150 First Byte

Your turn
1 Enter the text in the ‘Going to the movies’ example and save the worksheet calling it

‘Movies’.
2 Use a worksheet to enter your school timetable. It should look something like Figure 9.4.

Print the worksheet when it is complete.
3 For each of the following, create row and column headings that would be needed to

solve the problem:
a Work out the total cost of buying a new car. Costs will include the purchase price,

dealer costs, stamp duty, registration, insurance and extra items such as an air
conditioning unit.

b Create headings in a worksheet that compares the prices of four different cars. Use
advertisements from a newspaper to find the names and models of the cars. Use a
column heading ‘Price’ with a row for each type of car you identify.

c Create headings in a worksheet that will keep track of your results for assignments
and tests in your subjects at school. You will need to enter suitable headings and the
names of the subjects you are studying.

Entering numbers
Numbers can be entered in a cell by making that cell active and using the
keyboard to type in the number. Press the ENTER key once the number has been
entered.

Example—Going to the movies
The costs of transport ($4.50), ticket ($10.50), food ($5.95) and a drink ($4.25) give the
following spreadsheet (Figure 9.5).

Note that the width of column A has been altered to show all the text.

Figure 9.4 
A school 
timetable

Figure 9.5
Going to 
the movies
spreadsheet
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Your turn
1 Enter the numbers in the ‘Going to the movies’ example into your ‘Movies’ spreadsheet.
2 For each of questions 3a to 3c in the ‘Your turn’ on page 150, enter the costs and

amounts of money you have found in the appropriate cells.

Formatting numbers
Numbers are displayed by the worksheet in a variety of ways. The number 765
could be entered and formatted as:
• an integer (whole number)—765
• a decimal number with a specified number of decimal places—765.00
• money—$765 or $765.00
• a percentage—76500%.

A spreadsheet represents a date as a number. In Microsoft Excel, when a
number is formatted as a date, the number 1 refers to 1 January 1900, 2 is 2
January 1900, 3 is 3 January 1900 and so on. Thus 366 is 31 December 1900 (1900
was a leap year). The number 35 930 is the date 15 May 1998.

In Figure 9.5, the numbers have not been formatted in any way. Selecting the
cells B3 to B6 and formatting them as money gives the cells shown in Figure 9.6.

Your turn
1 Look at the Cells command on the Format menu and write down how many different

ways it allows you to format numbers.
2 Go back to the spreadsheets created above and format the numbers so that all money

amounts have ‘$’ signs in front of them. Large numbers should be formatted as whole
numbers and small amounts as dollars and cents.

3 Enter today’s date in a worksheet. What number does Excel use to represent that date?
4 Enter your birthday in a worksheet. What number does Excel use to represent your

birthday?

What is a formula?
A formula is used for making calculations. It consists of:

• an ‘=’ sign
• one or more cell references and operators such as ‘+’ for addition or ‘-’ for

subtraction.

Figure 9.6
Going to the
movies spreadsheet
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The formula ‘=A5+1’ means that 1 is added to the value stored in cell A5 and
the result is placed in the active cell. Figure 9.7 shows the value 45 in cell A5 and
the formula ‘=A5+1’ in cell A6, which has the value 46.

In calculating the cost of going to a movie, cell B8 will need a formula to work
out the total cost. The results are shown in Figure 9.8.

Cell B8 contains the formula ‘=B3+B4+B5+B6’. The formula is entered by
typing an ‘=’ sign followed by the cell references. Another method is to enter the
‘=’ sign and then click on each of the cells to be added together putting a ‘+’ sign
between each reference. The formula is shown in Figure 9.8(b).

BODMAS rules
BODMAS stands for: 

Brackets
Of
Divide
Multiply
Add
Subtract

BODMAS tells you the order in which calculations are to
be done. For example:

(9-7)*3 do the brackets first
=2*3 then multiply
=6
Excel follows the same rules, as shown in Figure 9.9. 

Figure 9.7
a and b
Using a formula 
in a spreadsheet

a b

Figure 9.8
a and b The cost 
of going to a movie

a b

Figure 9.9 
Excel using
BODMAS formula

Figure 9.10 
Worksheet 
showing the 
cost of buying a
house
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Your turn
1 Key in the worksheet in Figure 9.10 and save it as ‘House’.
2 Modify the spreadsheets you have created in the ‘Your turn’ on page 150 to include

simple formulae for the totals.

Using a function
Another way of doing additions is to use a function. A function is made up of:
• an ‘=’ sign
• a function name
• brackets or parentheses
• an argument—usually a range of cells to be used in the calculation.

Thus, B6 in Figure 9.9 could contain the function ‘=SUM(B1:B5)’. In this case
the function name is ‘SUM’ and the argument or range refers to all the cells from
B1 to B5 inclusive.

Microsoft Excel has a large range of functions. Another useful function is
‘AVERAGE’ which calculates the average of the numbers in the specified range.
For example, Figure 9.10 shows the runs scored for six cricketers, with the average
calculated in column F.

Figure 9.12 shows the same worksheet with the function for the average in
column F.

Your turn
1 Modify the worksheet you saved as ‘House’ to use the ‘SUM’ function to work out the

total cost.
2 Modify the worksheets you have created in the ‘Your turn’ on page 150 to include a

function for the totals.
3 Use a worksheet to enter the points scored by each National Basketball League team last

weekend (or use the results from another sport that interests you) and use the ‘AVERAGE’
function to calculate the average score.

Figure 9.11
Worksheet 
showing average
runs scored

Figure 9.12
Worksheet 
showing the 
function in 
column F
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What happens if a cell value is changed?
What happens to the cost of going to the movies if the price of the ticket goes up
but you spend less on food and drink? Entering the changed numbers in the
worksheet cell results in an instant recalculation of the result, as shown in 
Figure 9.13.

Example—Buying a house
What happens if the purchase price of the house is changed? Entering a new value in that cell
immediately results in a new value in cell B6 (see Figure 9.14).

Your turn
1 Enter the new amounts in your worksheet called ‘House’ and check the value of the total.
2 Alter the figures in your worksheets from the ‘Your turn’ on page 150 and note what

happens to the results.

Copying cells
Text, numbers and formulae can be copied from one cell to another, just like
using a word processor.

Example—Buying a house
What happens if you wish to compare the cost of two different houses? Create a second
column by adding the new numbers plus a heading in cell C1. The ‘TOTAL’ cell for the new
column can be created by copying it from B7. Select B7, copy it, move to cell C7 and paste it.
The worksheet in Figure 9.15 is the result.

Figure 9.13
Going to the 
movies after
some price 
changes

Figure 9.14
Changing the 
cost of buying 
a house

WORKSHEETWORKSHEET
939339399339

Buying a 
house
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The formula is copied from cell B7 to cell C7 and is shown in Figure 9.16.

Example—Comparing the movies and the cricket
Compare the cost of going to a movie with the cost of going to the cricket.

Select cells B3 to B8, copy them and paste them into cells C3 to C8.
Now, alter the text in cell C1 and the numbers in cells C3 to C8. The new result appears in

cell C8, as shown in Figure 9.17.
The formula is also copied from cell B8 to cell C8, as shown in Figure 9.18.

Your turn
1 Alter your ‘Movies’ worksheet to compare the cost of going to the movies and going to

the cricket.
2 Alter your ‘House’ worksheet to compare the cost of two different houses.
3 Alter your worksheet comparing the cost of different cars to add a column showing the

cost of last year’s model.

What is a relative reference?
The formula for calculating the total cost of going to the movies in cell B8 is
‘=B6+B5+B4+B3’.

Figure 9.15
Comparing the 
cost of two 
houses

Figure 9.16
Copying formulae

Figure 9.17
Comparing the
costs of a movie
and the cricket

Figure 9.18
Copying formulae
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Stored in B8 is a formula which says: ‘Add the value of the cell two cells up and
the value of the cell three cells up and the value of the cell four cells up and the
value of the cell five cells up’. Thus, when it is copied to cell C8 it works correctly,
adding up the numbers in column C.

These are called relative cell references because they refer to cells by their
position compared to the active cell. Figure 9.19 shows relative references.

Using Fill Down and Fill Right
The Fill Down and Fill Right commands on the Edit menu are used to copy the
contents of a cell into a range of adjacent cells.

The Fill Down command can, for example, be used to create a series of
numbers from 1 to 10. The number 1 is entered into cell A1 and the formula
‘=A1+1’ in cell A2. See Figure 9.20.

Now cells A2 through A12 are selected and the Fill Down command is used.

Figure 9.19
Relative references

a b

Figure 9.20 
a Screen display 
b Entering the 
formula

Figure 9.21
Fill menu 
items
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The screen display that results and the actual cell contents are shown in 
Figure 9.22.

The relative reference is copied from cell A2 into cells A3–A12, with the
numbers 2–12 being the results of the calculation. Remember that ‘=A1+1’ means
‘add 1 to the cell above’ as do ‘=A2+1’ and ‘=A3+1’ and so on.

Using the Fill Right command, a similar operation can be carried out to create a
row of relative references, as shown in Figure 9.23 (a). This results in the numbers
from 1 to 6 being displayed in the worksheet, as shown in Figure 9.23 (b).

The process of using Fill Down and Fill Right commands to create new cells is
called replication.

Your turn
1 Use the Fill Down command to enter the numbers from 1 to 12 in column A, starting at

cell A1.
2 Use the Fill Right command to enter the numbers from 1 to 12 in row 1, starting at cell

A1.
3 Enter the number 2 in cell A1 of a worksheet, then the formula ‘=A1*2’ in cell A2. Select

cells A2–A10 and fill down. What numbers appear in cells A3 to A10? What is the formula
in each of those cells?

Example—Creating a multiplication table
The Fill Down command can be used to create a multiplication table for any given number.
The process of creating a multiplication table for the number 5 is described below.
• Enter the number 5 in cell A3.
• Enter the formula ‘=A3’ in cell A4.
• Select the cells A4–A14 and choose Fill Down. This will put the number 5 in a column of 12

cells.

a b

Figure 9.22 
a Screen display 
b Actual cell 
references

a

b

Figure 9.23 
a Creating a row of
relative references 
b The result of using
the Fill Right
command
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• Enter the symbol for multiplication (*) in cell B3 and then select cells B3–B14 and choose
Fill Down. This puts the * sign in each cell.

• Use a similar method to put an ‘=’ sign in cells D3–D14.
• Enter the number 1 in cell C3, the formula ‘=C3+1’ in cell C4 and then select C4–C14 and

choose Fill Down. This puts the numbers 1 to 12 in cells C3 to C14.
• In cell E3 enter the formula ‘=A3*C3’, then select cells E3–E14 and choose Fill Down. The

result and cell contents are shown in Figure 9.24.

Entering a new number in cell A3 creates a new multiplication table.

Your turn
Create the multiplication table in the previous example following the steps given. What
happens if the number in cell A3 is changed from 5 to 6?

What is an absolute reference?
When you want to store a reference to a cell that will not change with the copy or
fill command, you must refer to the absolute cell reference. This is done by using $
signs in the cell reference.

Example—Increasing the price
A trader decides to increase the price of each item of stock by 10%. Five items of stock are
affected by this price increase. The value 10% is entered in cell C1. This will be used to work
out the increase in the price of each item. Item A has a price of $50.00 (cell B4). The price
increase is calculated by multiplying the value in cell B4 by the value in cell C1. The result,
$5.00, is stored in cell C4. To get the new price, add cells B4 and C4 and store the result in cell
D4 (see Figure 9.25).

Figure 9.24
Screen display 
and actual cell
references

Figure 9.25
Calculating a 
percentage price
increase
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The formula that is entered in cell C4 is ‘=B4*$C$1’. This formula means that to get the
price increase in cell C4, you multiply the contents of cells B4 and C1. The formula for cell D4
is ‘=B4+C4’.

This process is repeated for each item. For item B, multiply the values in cells B5 and C1,
and store the result in C5. Then add cells B5 and C5, and store the result in cell D5.

The $ sign shows that when the formula is created by copying to the cells below it always
refers to the cell C1. That is, $C$1 is an absolute reference. This is shown in Figure 9.26.

‘What if’ analysis
When important data in a worksheet is changed, a new result is immediately
calculated. This is called ‘What if’ analysis. For example, what if the rate of
increase in the product price was 15% instead of 10%? Entering 15% in cell C1
causes the worksheet to recalculate the results.

‘What if’ analysis is used to check what happens when figures change. It is
particularly useful when working out figures that involve money.

Figure 9.26
Actual cell
references
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Your turn
1 Create the worksheet in Figure 9.25, making sure that cell C1 contains an absolute

reference. Change the value in cell C1 to 15%, 20% and 5%, and write down the new
prices in each case.

2 Create the worksheet in Figure 9.27 which calculates the value of a house over time.
Assume that the property purchase price is $140 000 and that the house will increase in
value at the rate of 5% each year. Note that the formulae in column B refer to an
absolute reference for cell B2. Change the values of B1 and B2 to answer the following
questions:
a What would the value of the house be after 10 years if the inflation rate is 10%?
b What would the value of the house be after 10 years if the inflation rate is 7%?
c What would the value of a house that cost $195 000 be after 10 years if the inflation

rate was 4%, 6% or 10%?

3 A new car depreciates in value each year. That is, the value of the car decreases by a certain
percentage. Set up a worksheet that includes a cell for the original value of the car, the
depreciation rate and the value of the car after each year for six years. Start with a car of
value $31 000 and a depreciation rate of 25%. Remember to use an absolute value when
referring to the cell with the depreciation rate.

Printing a worksheet
Small worksheets are easily printed on one page of paper. However, large
worksheets may take several sheets of paper and care must be taken to ensure that
they are printed out in the correct order, and that page breaks are in appropriate
places.

Microsoft Excel allows the user to set the area of a worksheet to be printed.
This is done by:

• selecting the range of cells to be printed
• choosing the Set Print Area command on the File menu.

Figure 9.27 
a Screen display 
b Actual cell 
references

a b
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The Print Preview command, also on the File menu, gives a reduced view of
each page. It is useful for ensuring that page breaks are in the correct place.

Excel allows a lot of flexibility in printing. The page can be printed in either
portrait or landscape mode. Other options include printing with or without
gridlines and with or without column and row headings. Headers and footers
displaying page numbers, date, time, document title and other information may
also be included. Top, bottom, left and right margins may be adjusted. These
dialogue boxes are all accessed from the Page Setup... command on the File
menu.

Figure 9.28
Setting the 
print area

Figure 9.29
Dialogue box from
the Page Setup
command
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Charts
Cells of a worksheet may be selected
and a chart created by Excel. These
charts are very useful for displaying
information. Excel chart types
include:

• column
• pie
• bar
• area
• line.

The worksheet in Figure 9.31 tracks the price of Telstra shares over an eight
day period.

Example—line graph
These prices can be represented on a line graph as shown in Figure 9.32. To create this graph,
take the following steps:
• Select the cells to be represented on the chart.
• Choose the Chart Wizard from the toolbar.
• Choose the chart type from the list and select a particular line graph.
• Click the Next button and then confirm the range of cells.
• Click the Next button and enter a chart title and titles for the X and Y axes 

if required.
• Click the Next button and choose to have the chart as part of the worksheet

or as a chart with its own sheet.
The labels for the horizontal (X-axis) and vertical (Y-axis) axes are generated by

Excel.

Figure 9.31
Telstra share prices

Figure 9.30
Excel chart types
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Pie charts are useful for representing data such as a budget so that the
contribution of each item can be shown.

Example—pie chart
Carrying out the following steps using the ‘Movies’ worksheet could create a pie chart of
these figures.
• Select the cells of the worksheet to be used—that is, A3 to B6.
• Choose the Chart Wizard from the toolbar.
• Choose the chart type from the list and select a pie chart type—the one 

with a 3D visual effect.
• Click the Next button and confirm the range of cells.
• Click the Next button and enter a chart title then click the Finish button.

Note that the default font size of the chart title is 12 point bold Arial and for
the legend it is 10 point Arial.

The result should look something like Figure 9.33.

Figure 9.32
A line graph of 
share prices

Figure 9.33
Pie chart showing
the cost of going to
a movie
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Bar charts are used for making comparisons. For example, Figure 9.34
compares the costs of going to a movie and going to the cricket. Note the
addition of a legend on the right side of the chart.

Your turn
1 Use the figures on the preceding pages to create worksheets and draw the charts shown

in Figures 9.32, 9.33 and 9.34. In each case, alter the figures and note the changes to the
charts.

2 Find out the prices of ten different items in the supermarket. Enter the prices on a
worksheet and use a bar chart to show the comparison.

Now try these
1 Use a worksheet to work out the cost of purchasing a personal computer. Include the 

cost of the computer, software, CD-ROMs, a printer and a modem.
2 Create a worksheet to work out the profit for a month’s trading by a service station. The

income is made up of petrol and oil sales of $39 563, labour charges of $13 445 and
spare parts sales of $4503. The expenses are made up of salaries $12 000, rent $6500
and the cost of goods (petrol, oil, spare parts) $19 766.

3 Compile a list of fifteen different items that may be purchased at a supermarket. Use a
worksheet to list the items. Find out the prices of the items from two different
supermarkets, enter them on the worksheet and compare the total prices.

4 Create a worksheet to work out the annual salaries of a company after a pay rise. Use
cell A3 to contain the pay rise percentage and use an absolute reference in the formula
you create. Try the spreadsheet with the following figures:

Surname Initials Old Salary New Salary
Carey P J $35 500
Peters R F $23 000
Rowland K M $43 555
Cobb J J $18 433

▲

Figure 9.34
Bar chart showing 
comparative costs 
of going to a 
movie and the 
cricket
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5 The Coles Myer share price over a period of 10 weeks was:
Week 1 $6.61
Week 2 $6.55
Week 3 $6.58
Week 4 $6.88
Week 5 $6.92
Week 6 $6.84
Week 7 $7.25
Week 8 $7.18
Week 9 $7.32
Week 10 $7.20

Use a worksheet to enter this data and draw it as a chart. Save the chart as a web page
and open the chart using a browser. Open the table of data using a browser.

6 Store the share prices of a number of companies on worksheets. Add the hyperlinks to 
the worksheets so you can move from one worksheet to another.

Projects

1 Planning a holiday
You are required to draw up a budget for a family holiday to North Queensland.
Use a spreadsheet to work out costs for a family of four including:
• travel
• accommodation
• car hire
• living expenses
• souvenirs
• cost of trips and excursions, for example, diving on the Great Barrier Reef.

You should investigate costs of different travel, accommodation and car hire to
ensure that you have the best price.

2 Share portfolio
You are required to establish and manage a portfolio of Australian shares to the
value of $100 000.

Use a spreadsheet to establish a portfolio that includes at least 10 different
shares. The spreadsheet should allow you to enter the current value of the shares
at any time and to compare this to the purchase price.

The spreadsheet should also allow you to estimate the dividend income from
the shares and give a total return on the investment.

3 Comparing house prices
You are asked to compare house prices in ten suburban areas in the capital city of
your state. Use the median prices for suburbs that are available in the weekend
newspapers.

Use a spreadsheet to answer the following questions:
• Which suburb is the most expensive?
• Which suburb is the least expensive?
• Which suburb had the largest increase in value in the last twelve months?
• Which suburb had the smallest increase in value in the last twelve months?
• Have the prices dropped in any suburbs in the last twelve months?


